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Welcome to Teachucomp, Inc.’s Outlook course.

Outlook is a multi-featured program in which you can

create e-mail, manage your calendar, assign tasks for

yourself and others, and create public forums for

discussion.

This class is designed to give the student with

knowledge of the e-mail, task and scheduling capabilities

of the Outlook application additional enhancements to their

skill set.

Outlook is a terrific program to learn, as the skills that

we learn in Outlook can save valuable time and money by

automating, organizing and structuring the scheduling and

management capabilities of your company.

Introduction and Overview
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The Journal Folder

9.1- The Journal Folder:

The Journal feature of Outlook can be used to record multiple types of interactions. You can record

interactions with important contacts, when documents or items are created and accessed, or many other

types of activities. In Outlook 2010:2007, you can configure the Journal to record these items and activities

manually or automatically. Starting in Outlook 2013, you may only record activities manually, as automatic

journaling is now always disabled.

In Outlook 2013, the “Journal” tab has been removed from the Navigation Bar. You may only access

the Journal using the “Folders” option within the Navigation Bar and then selecting the “Journal” folder from

the Folder Pane. You also will no longer have access to “Notes and Journal” or “Journal Options” within the

“Outlook Options” dialog box. Note that it appears that Microsoft is slowly deprecating the Journal feature,

and you should avoid relying on the Journal feature as it may disappear entirely in future releases if this

trend continues.

In all versions of Outlook, you can open the Journal folder by clicking the “Folders” or “Folder List”

button in the Navigation Bar, and then selecting the “Journal” folder from the Folder Pane. The first time that

you access the Journal if using Outlook 2010:2007, it prompts you to turn journaling on, as it is turned off by

default. If you wish to use the Journal feature, you can click “Yes.” Even if you click “No,” you can enable it

at a later point in time. Note that this feature is no longer available in Outlook 2013.

Each Journal entry made within the Journal folder represents one activity. You can open a journal

entry to examine the details of the activity associated with the entry. From there, you can use the entry as a

way to access the associated file (if applicable) or the Outlook item to which the journal entry refers.

By default, the Journal organizes entries in chronological order. However, you can reorganize the

view of the Journal in much the same way that you can modify the view of any folder in Outlook.

9.2- Switching the Journal View:

The Journal can be viewed in many different ways. To switch the Journal view in Outlook

2013:2010, you can click one of the view icons shown in the “Current View” group on the “Home” tab in the

Ribbon when viewing the Journal folder. To switch the view of the Journal in Outlook 2007, you can select

“View| Current View” from the Menu Bar, and then select the name of a view that you wish to see from the

side menu of view choices that appears.

In the default timeline view of the Journal you can group the entries by item types, associated

contact names, or categories. In Outlook 2013:2010, you can do this by clicking the “View” tab in the Ribbon

and then selecting the desired grouping from the icons shown in the “Arrangement” button group. You can

also switch the timeline view to show different increments of time. If using Outlook 2013:2010, you can do

this by clicking the buttons shown in the “Arrangement” button group on the “Home” tab in the Ribbon. If

using Outlook 2007, you can do this by clicking the “Day,” “Week,” or “Month” buttons on the Standard

Toolbar.

You can also navigate to the specific days or months for which you want to see the associated

Journal entries. You can scroll left and right to move through the days, weeks, or months depending on your

view, or you can click the heading shown within the “Timeline” view of the Journal, and then select a date

from the calendar drop-down that appears to select that date within the Journal.
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The Journal Folder

9.3- Recording Journal Items Automatically- 2010:2007:

If you click “Yes” to enable the Journal when you first switch to the Journal view, you can then

instantly configure what items to track automatically in the “Journal Options” dialog box.

If you need to access this dialog box at a later point in time to change or edit what the Journal

tracks, you can. To do this in Outlook 2010, click the “File” tab in the Ribbon, and then click the “Options”

command at the left side of the screen. In the “Outlook Options” dialog box that opens, click the “Notes and

Journal” category at the left side. To the right of that, click the “Journal Options…” button to open the

“Journal Options” dialog box. To do this in Outlook 2007, select “Tools| Options…” from the Menu Bar. Then

click the “Preferences” tab in the “Options” dialog box, and click the “Journal Options…” button to open the

“Journal Options” dialog box.

In the “Automatically record these items” section, check the checkbox in front of each item type that

you want the Journal to automatically record. Then, in the “For these contacts” section, click the checkbox in

front of each contact name for which you want the Journal to automatically record the previously checked

item types. In the “Also record files from” section, you can click the checkbox in front of each Microsoft

Office application for which you want the Journal to track the use of files. Finally, select one of the two

option buttons that decide what happens when you double click on a Journal entry: open the entry, or open

the item referred to by the entry.

When finished, click “OK” to set the Journal options, and then click “OK” again to close the “Options”

dialog box.

9.4- Recording Journal Items Manually:

You can also manually create a Journal entry. To do this in Outlook 2013:2010, click the “Journal

Entry” button in the “New” group on the “Home” tab in the Ribbon when viewing the Journal folder. To do

this in Outlook 2007, select “File| New| Journal Entry…” from the Menu Bar.

In the “Journal Entry” window that then appears, you start by typing a subject for the entry into the

“Subject:” text box. Then select what type of entry you want to classify this as being by using the “Entry

type:” drop-down. You can type a company name into the “Company:” text box, if needed. Then input the

“Start time:” of the activity that you are recording and set the “Duration” of the activity, if necessary. In the

large white text box, you can type any additional information you would like to record about the entry.

Note that if you wish to attach a file to this journal entry, then ensure that you have selected the

correct type of file that you will be attaching from the “Entry type” drop-down. Then click the “Insert” tab

within the Ribbon. You can then click either the “Attach File” or “Outlook Item” buttons to open a dialog box

that will allow you to navigate to and then select either the Office file or Outlook item to attach to this journal

entry. Select the item within the dialog box that appears and then click the “Insert” or “OK” buttons to insert

the file into the journal entry.

Like appointments and tasks, you can click the “Categorize” button in the “Tags” group (“Options”

group in 2007) on the “Journal Entry” tab in the Ribbon to classify the Journal entry to one or more

categories. Also notice that you can click the “Private” button in the same group to mark it as a “private” item

within Outlook. Items you mark as private cannot be seen by delegates with access to your Journal folder,

unless you specifically grant them that permission.

When you are finished editing the journal entry, click the “Save and Close” button in the “Journal

Entry” tab within the Ribbon of the “Journal Entry” window to have Outlook save and close the entry.
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The Journal Folder

9.5- Opening Journal Entries and Documents:

You can open journal entries that you have recorded in the Journal. If the entry is associated with an

attached Outlook item or Office document, then you can also open the associated file as well. Once the

journal entry is open, you can edit or modify the journal entry information. In journal entries that are

associated with an Office document, editing the Journal entries will not impact the associated document in

any way. In the Journal folder, you can also delete journal entries without having to worry about deleting the

associated Office document. It is also true that you can edit or delete an Office document and it will not

affect the associated Journal entry.

To open a journal entry, you can right-click on the entry that you wish to open and then click the

“Open Journal Entry” command within the pop-up menu that appears. If you wish to open the Outlook item

or Office document that is attached to the journal entry, you can right-click on the journal entry and then

click the “Open Item Referred To” command from the pop-up menu that appears.

You can also simply double-click on the entry to open the “Journal Entry” window in Outlook 2013. If

using Outlook 2010:2007, you can configure whether double-clicking a journal entry will open the actual

entry itself or the document or item referred to by the entry by making a selection within the “Journal

Options” dialog box.

9.6- Deleting Journal Items:

To delete journal entries, select the journal entry that you want to delete within the Journal folder

and then press the “Delete” or “Del” key on your keyboard. You can also select multiple journal entries by

simply clicking on each one while holding down the “Shift” or “Ctrl” keys on your keyboard to make adjacent

or non-adjacent selections, as needed. You can then press the “Delete” or “Del” key on your keyboard to

delete the selected entries.

If you need to delete all of the entries in a particular Journal category (under an “Entry Type” journal

heading section), you can just right-click on the heading, and select the “Delete” command from the pop-up

menu that appears. Outlook will tell you that this will apply to all of the items in the selected groups. Click

“OK” to continue and delete the items in that group, or “Cancel” to cancel the deletion if you are unsure.
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ACTIONS-

The Journal Folder
OPENING THE JOURNAL FOLDER:

1. In all versions of Outlook, you can open the Journal folder by clicking the “Folders” or “Folder List” 

button in the Navigation Bar, and then selecting the “Journal” folder from the Folder Pane.

2. The first time that you access the Journal if using Outlook 2010:2007, it prompts you to turn journaling 

on, as it is turned off by default. To use the Journal feature, you can click “Yes.” Even if you click “No,” 

you can enable it at a later point in time. Note that this feature is no longer available in Outlook 2013.

3. Each Journal entry made within the Journal folder represents one activity. You can open a journal entry 

to examine the details of the activity associated with the entry. From there, you can use the entry as a 

way to access the associated file (if applicable) or the Outlook item to which the journal entry refers.

CHANGING JOURNAL VIEWS:

1. To switch the Journal view in Outlook 2013:2010, click one of the view icons shown in the “Current 

View” group on the “Home” tab in the Ribbon.

2. To switch the view of the Journal in Outlook 2007, select “View| Current View” from the Menu Bar and 

then select the name of a view that you wish to see from the side menu of view choices that appears.

3. In the default timeline view of the Journal you can group the entries by item types, associated contact 

names, or categories. In Outlook 2010, you can do this by clicking the “View” tab in the Ribbon and then 

selecting the desired grouping from the icons shown in the “Arrangement” group.

4. You can show different increments of time in the timeline view. If using Outlook 2010, you can do this by 

clicking the buttons shown in the “Arrangement” group on the “Home” tab in the Ribbon. If using Outlook 

2007, you can do this by clicking the “Day,” “Week,” or “Month” buttons on the Standard Toolbar.

5. You can also navigate to the specific days or months for which you want to see the associated Journal 

entries. You can scroll left and right to move through the days, weeks, or months depending on your 

view, or you can click the heading of the Journal, and select a date from the calendar drop-down that 

appears to jump to that date in the Journal.

RECORDING JOURNAL ITEMS AUTOMATICALLY- 2010 & 2007 ONLY:

1. If you click “Yes” to enable the Journal when you first switch to the Journal view, you can then instantly 

configure what items to track automatically in the “Journal Options” dialog box.

2. You can access this dialog box later to change what the Journal tracks. To do this in Outlook 2010, click 

the “File” tab in the Ribbon, and then click the “Options” command at the left side of the screen. In the 

“Outlook Options” dialog box that opens, click the “Notes and Journal” category at the left side. To the 

right of that, click the “Journal Options…” button to open the “Journal Options” dialog box. To do this in 

Outlook 2007, select “Tools| Options…” from the Menu Bar. Then click the “Preferences” tab in the 

“Options” dialog box, and click the “Journal Options…” button to open the “Journal Options” dialog box.

3. In the “Automatically record these items” section, check the checkbox in front of each item type that you 

want the Journal to automatically record. In the “For these contacts” section, click the checkbox in front 

of each contact name for which you want to automatically record the previously checked item types.

4. In the “Also record files from” section, you can click the checkbox in front of each Microsoft Office 

application for which you want the Journal to track the use of files.

5. Select one of the two option buttons that decide what happens when you double click on a Journal 

entry: open the entry, or open the item referred to by the entry.

6. Click “OK” to set the Journal options, and then click “OK” again to close the “Options” dialog box.Sa
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ACTIONS-

The Journal Folder
RECORDING JOURNAL ITEMS MANUALLY:

1. If using Outlook 2013:2010, click the “Journal Entry” button in the “New” group on the “Home” tab in the 

Ribbon when viewing the Journal folder. If using Outlook 2007, select “File| New| Journal Entry…” from 

the Menu Bar.

2. In the “Journal Entry” window that then appears, start by typing a subject for the entry into the “Subject:” 

text box.

3. Select what type of entry you want to classify this as being by using the “Entry type:” drop-down.

4. You can type a company name into the “Company:” text box, if needed.

5. Input the “Start time:” of the activity that you are recording and set the “Duration” of the activity, if 

necessary.

6. In the large white text box, type any additional information you would like to record about the entry.

7. If you wish to attach a file to this journal entry, ensure that you have selected the correct type of file that 

you will be attaching from the “Entry type” drop-down.

8. Then click the “Insert” tab within the Ribbon.

9. You can then click either the “Attach File” or “Outlook Item” buttons to open a dialog box that will allow 

you to navigate to and then select either the Office file or Outlook item to attach to this journal entry.

10. Select the item within the dialog box that appears and then click the “Insert” or “OK” buttons to insert the 

file into the journal entry.

11. You can click the “Categorize” button in the “Tags” group (“Options” group in 2007) on the “Journal 

Entry” tab in the Ribbon to classify the Journal entry to one or more categories.

12. You can click the “Private” button in the same group to mark it as a “private” item within Outlook.

13. When you are finished editing the journal entry, click the “Save and Close” button in the “Journal Entry” 

tab within the Ribbon of the “Journal Entry” window to have Outlook save and close the entry.

OPENING JOURNAL ENTRIES AND DOCUMENTS:

1. To open a journal entry, right-click on the entry that you wish to open and then click the “Open Journal 

Entry” command within the pop-up menu that appears.

2. If you wish to open the Outlook item or Office document attached to the journal entry, you can right-click 

on the journal entry and then click the “Open Item Referred To” command from the pop-up menu that 

appears.

3. You can also simply double-click on the entry to open the “Journal Entry” window in Outlook 2013.

4. If using Outlook 2010:2007, you can configure whether double-clicking a journal entry will open the 

actual entry itself or the document or item referred to by the entry by making a selection within the 

“Journal Options” dialog box.
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ACTIONS-

The Journal Folder
DELETING JOURNAL ITEMS:

1. To delete journal entries, select the journal entry that you want to delete within the Journal folder and 

then press the “Delete” or “Del” key on your keyboard.

2. You can also select multiple journal entries by simply clicking on each one while holding down the 

“Shift” or “Ctrl” keys on your keyboard to make adjacent or non-adjacent selections, as needed. You can 

then press the “Delete” or “Del” key on your keyboard to delete the selected entries.

3. To delete all of the entries in a particular Journal category (under an “Entry Type” journal heading 

section), you can right-click on the heading, and select the “Delete” command from the pop-up menu 

that appears.

4. Outlook will tell you that this will apply to all of the items in the selected groups.

5. Click “OK” to continue and delete the items in that group, or “Cancel” to cancel the deletion if you are 

unsure.

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



12Advanced Outlook©TeachUcomp, Inc.

EXERCISES-

The Journal Folder
Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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CHAPTER 10-

Public Folders

10.1- Creating Public Folders

10.2- Setting Permissions

10.3- Folder Rules

10.4- Copying Public Folders
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Public Folders

10.1- Creating Public Folders:

With Outlook, you can create public folders to which you can post public conversation topics or any

type of item that Outlook can store in its normal folders like e-mail, calendars, and tasks. This is a terrific

feature to use for setting up meetings, scheduling your employees’ tasks, and posting general information

topics into a folder that you want to be accessible to the people on your network. To benefit from this

feature, however, you do need to use Outlook with a Microsoft Exchange Server 2003 or later on your

network.

To select and view a public folder, you must expand the “Public Folders” folder and then expand the

“All Public Folders” folder in the Folder List. You can view the Folder List in Outlook by clicking the “Folder

List” button at the bottom of the Navigation Bar. If you have public folders already created in this folder, you

can double-click the “All Public Folders” folder to view the public folders that have already been created.

You can then click on one of the public folders in the list to view its contents.

To create a public folder, click the “All Public Folders” folder in the Folder List to select it. If using

Outlook 2013:2010, click the “New Folder” button in the “New” button group on the “Folder” tab in the

Ribbon. If using Outlook 2007, then select “File| New| Folder…” from the Menu Bar. You should see the

“Create New Folder” dialog box appear. In this dialog box you must type in a name for your new folder in

the “Name:” text box. Next, you must use the drop-down menu for the “Folder contains:” text box to select

what type of Outlook items will be stored in that folder. Finally, select where to place the new folder in the

folder list from the “Select where to place the new folder:” navigation list. When you have finished, click

“OK.” This will place the new public folder in the place within the Folder List where you selected to insert it.
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Public Folders

10.2- Setting Permissions:

After creating the folder, you are the folder’s

“owner.” It is up to you to decide which users on your

network can access the folder, and also what types of

activities they can do if they do have access to the

folder. If you are the folder’s owner, or have been

given the owner permission by the folder’s owner, you

can set the folder’s permissions by right-clicking on the

public folder for which you want to set the permissions

and selecting the “Properties” command from the pop-

up menu that appears.

This will launch the “Properties” dialog box

where you will be able to set the permissions for the

selected public folder. If you see a tab that says

“Summary,” that means that you do not have the

required permission level to modify the permissions for

that folder. If you believe that you should have that

permission level, contact your Network Administrator

or the folder’s owner to change your permission level.

If you can set permissions, then you should

see a tab that says “Permissions” when you open the

“Properties” dialog box. Click that tab to view the

permissions that have been set for the folder. There

are three permissions created by default: the folder

owner’s permission, the “Default” permission, and the

“Anonymous” permission. The “Default” permission is the permission level granted to all of the other users

on the network who do not have explicitly defined permissions for the selected folder.

You can modify the permission level of the “Default” identity to change the permission level of all of

the users who access this public folder. Simply click the “Default” identity from the list at the top of the

“Permissions” tab, and look to see what permissions have been set for that role in the “Permissions:”

section located below it. You can then use the “Permission Level:” drop-down menu to change the role of

the “Default” permission. That will modify the associated abilities listed beneath the “Permission Level:”

drop-down box, depending on the permission level that you choose from the list.

Depending on the type of material you will be placing in the folder, you may want to completely

restrict access to the “Default” permission, and then specify permissions for each individual user on the

network to whom you wish to grant folder access. If the material needs to be accessed by everyone, you

could also change the “Default” permission so that at least everyone can see the material in the folder, if not

edit it. Then you could add users to whom you want to grant editing and deleting permissions in that folder.

You can add individuals or groups to the permission list of the folder as long as they are on your

network. That way you can modify the permission levels of the individual users and user groups in your

network. This allows you to have more control over who has access to your public folder, and what activities

they can perform in the folder. You can also delete user permissions that are no longer applicable. For

example, if a user were to leave the office, you should delete any access to the public folders that they had.

If you are interested in setting strict security over the contents of the folder, consider adding and

setting individual permissions for only the users that you want to have access to the public folder and thenSa
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Public Folders

10.2- Setting Permissions (cont.):

setting the “Default” permission level to “None.”

To add a user or user group on the “Permissions” tab, click the “Add…” button below the list of user

permissions for the folder. That will launch the “Add Users” dialog box. This is similar to the “Select Names”

dialog box that is used to address e-mail. You simply select the user or users that you want to add from the

list, and click the “Add” button to move the users into the text box at the bottom. When you have finished

adding the users for which you want to set individual folder permissions, click “OK” to add them to the

“Permissions” list. Then, to specify each user’s permission settings, select their names in the “Permissions”

list, and select a role from the “Permission Level:” drop-down below the list.

You can set the “Permission Level:” of any selected user or user group which you have granted

folder access to by selecting one of these permission levels from the “Permission Level:” drop-down in the

“Permissions” tab of the “Properties” dialog box of the public folder that you have selected. Simply click the

user or user group name from the “Name:” list at the top of the “Permissions” tab, and then select the

“Permission Level:” from the “Permissions” section beneath that.

Permission Level: Grants to the User:

Owner Can create, read, change, or delete any items in the folder. Can create subfolders.

Can grant and modify all permissions for the folder.

Publishing Editor Can create, read, change, and delete all items. Can create subfolders.

Editor Can create, read, change, and delete all items.

Publishing Author Can create and read items and create subfolders.

Can also change and delete items they created.

Author Can create and read items. Can also change and delete items they created.

Nonediting Author Can create and read items.

Reviewer Can read items only.

Contributor Can create items only. The contents of the folder will not appear (no read access).

Custom Can perform any activities specified by the folder’s owner.

None Has no permission in the folder.

The folder owner can create a “Custom” permission level by manually applying the desired

individual permission level settings below the “Permission Level:” drop-down. This allows you to create your

own permission settings, in case the permission levels specified do not fully allow or restrict the particular

activities desired by the owner.

Once you have set the permission levels for the folder as desired, just click “OK” at the bottom of the

folder properties dialog box to set the permissions into effect.
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Public Folders

10.3- Folder Rules:

Within the “Properties” dialog box of a selected public folder, you can click the “Folder Assistant…”

button on the “General” tab in Outlook 2013:2010 or on the “Administration” tab in Outlook 2007 to create,

edit, delete, or turn on and off the rules you have created. Setting up rules for a folder is a fairly

straightforward concept. A folder rule simply states that when items arrive to the folder that meet a specified

criteria they will then be processed by whatever the rule dictates should happen when an item of that type is

received. You can have multiple rules applied to a single folder. The rules will be acted upon in sequence

from top to bottom through the list of rules. They can also be modified at a later date or deleted entirely if

they no longer apply. You can also turn them on and off without having to delete and recreate them.

In the “Folder Assistant” dialog box, click “Add Rule…” to launch the “Edit Rule” dialog box. Here

you can set the condition that the rule will act upon. It could be when the item is either “From…” an

individual or “Sent To…” an individual. If that is the case, you will need to click the appropriate button, and

select the correct name(s). You can check the “Sent directly to” and/or “Copied (Cc) to” to include those

types of items as well. You can also specify the “Subject:” or “Message body:” content that the rule will act

upon by typing what you want the rule to act upon in those text boxes.

Once you have set up what will trigger the action of the rule, all that is left is to specify what the rule

will do when it receives an item in the folder that matches the criteria you set. You can check either “Return

to Sender,” “Delete,” “Reply with” or “Forward.” You can select more than one action, if desired. Also, if you

are replying, you must click the “Template…” button and type up what you want as the reply in the body of

the e-mail message that appears. If you click “Forward,” you will have to click the “To…” button to select a

recipient. You can also set the format of the forwarded message by using the “Method:” drop-down below

that.

When you are finished, click the “OK” button to set the folder rules. Then click “OK” in the “Folder

Assistant” dialog box to set the rule. Notice that the rule appears in the “Folder Assistant” dialog box with a

check in front of it. You can turn a rule off by returning here and clearing the check from the checkbox to

shut the rule off. You can turn it back on by simply clicking the same checkbox to put the rule in place again.

10.4- Copying Public Folders:

You can copy public folders in your network. This allows you to also copy all of the permissions,

administrative settings, and rules from the copied folder to the new folder so that you won’t have to reset

them all over again as would be the case if you started with another new folder. If the folders will have

similar settings, this can be a time-saving task. Even editing a public folder’s properties is often easier than

having to recreate them all from scratch. Once you have copied the folder from one place to another, you

should edit its properties accordingly and rename it.

To copy a public folder, right-click the public folder that you want to copy, and select “Copy [Folder

name]…” from the pop-up menu that appears. This will launch the “Copy Folder” dialog box. Select the

folder under which you want to place the copy of the original folder, and then click “OK.”
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ACTIONS-

Public Folders
VIEWING AND CREATING A PUBLIC FOLDER:

1. To select and view a public folder, you must expand the “Public Folders” folder and then expand the “All 

Public Folders” folder in the Folder List. You can view the Folder List in Outlook by clicking the “Folder 

List” button at the bottom of the Navigation Bar.

2. If you have public folders already created in this folder, you can double-click the “All Public Folders” 

folder to view the public folders that have already been created.

3. You can then click on one of the public folders in the list to view its contents. 

4. To create a public folder, click the “All Public Folders” folder in the Folder List to select it.

5. If using Outlook 2013:2010, click the “New Folder” button in the “New” button group on the “Folder” tab 

in the Ribbon. If using Outlook 2007, then select “File| New| Folder…” from the Menu Bar.

6. In the “Create New Folder” dialog box that appears, you type a name for your new folder in the “Name:” 

text box.

7. Next, you must use the drop-down menu for the “Folder contains:” text box to select what type of 

Outlook items will be stored in that folder.

8. Finally, select where to place the new folder in the folder list from the “Select where to place the new 

folder:” navigation list.

9. When you have finished, click “OK.”

SETTING FOLDER PERMISSIONS:

1. You can set the folder’s permissions by right-clicking on the public folder for which you want to set the 

permissions and selecting the “Properties” command from the pop-up menu that appears.

2. This will launch the “Properties” dialog box where you will be able to set the permissions for the selected 

public folder. If you see a tab that says “Summary,” that means that you do not have the required 

permission level to modify the permissions for that folder.

3. If you can set permissions, then you should see a tab that says “Permissions” when you open the 

“Properties” dialog box. Click that tab to view the permissions that have been set for the folder.

4. To add a user or user group on the “Permissions” tab, click the “Add…” button below the list of user 

permissions for the folder. That will launch the “Add Users” dialog box. Here you select the user or users 

that you want to add from the list, and click the “Add” button to move the users into the text box at the 

bottom. When you have finished adding the users for which you want to set individual folder 

permissions, click “OK” to add them to the “Permissions” list.

5. Then, to specify each user’s permission settings, select their names in the “Permissions” list and then 

select a role from the “Permission Level:” drop-down below the list.

6. The folder owner can create a “Custom” permission level by manually applying the desired individual 

permission level settings below the “Permission Level:” drop-down. This allows you to create your own 

permission settings, in case the permission levels specified do not fully allow or restrict the particular 

activities desired by the owner.

7. Once you have set the permission levels for the folder as desired, just click “OK” at the bottom of the 

folder properties dialog box to set the permissions into effect.
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ACTIONS-

Public Folders
FOLDER RULES:

1. Within the “Properties” dialog box of a selected public folder, you can click the “Folder Assistant…” 

button on the “General” tab in Outlook 2013:2010 or on the “Administration” tab in Outlook 2007 to 

create, edit, delete, or turn on and off the rules you have created.

2. In the “Folder Assistant” dialog box, click “Add Rule…” to launch the “Edit Rule” dialog box.

3. Here you can set the condition that the rule will act upon. It could be when the item is either “From…” an 

individual or “Sent To…” an individual. If that is the case, you will need to click the appropriate button, 

and select the correct name(s).

4. You can check the “Sent directly to” and/or “Copied (Cc) to” to include those types of items as well. You 

can also specify the “Subject:” or “Message body:” content that the rule will act upon by typing what you 

want the rule to act upon in those text boxes.

5. Once you have set up what will trigger the action of the rule, all that is left is to specify what the rule will 

do when it receives an item in the folder that matches the criteria you set. You can check either “Return 

to Sender,” “Delete,” “Reply with” or “Forward.” You can select more than one action, if desired.

6. Also, if you are replying, you must click the “Template…” button and type up what you want as the reply 

in the body of the e-mail message that appears.

7. If you click “Forward,” you will have to click the “To…” button to select a recipient.

8. You can also set the format of the forwarded message by using the “Method:” drop-down below that.

9. When you are finished, click the “OK” button to set the folder rules.

10. Then click “OK” in the “Folder Assistant” dialog box to set the rule.

11. Notice that the rule appears in the “Folder Assistant” dialog box with a check in front of it. You can turn a 

rule off by returning here and clearing the check from the checkbox to shut the rule off. You can turn it 

back on by simply clicking the same checkbox to put the rule in place again.

COPYING PUBLIC FOLDERS:

1. To copy a public folder, right-click the public folder that you want to copy, and select “Copy [Folder 

name]…” from the pop-up menu that appears. This will launch the “Copy Folder” dialog box.

2. Select the folder under which you want to place the copy of the original folder, and then click “OK.”
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EXERCISES-

Public Folders
Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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CHAPTER 11-

Personal & Private Folders

11.1- Creating a Personal Folder

11.2- Setting AutoArchiving for Folders

11.3- Creating Private Folders

11.4- Creating Search Folders
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Personal & Private Folders

11.1- Creating a Personal Folder:

You can create a Personal Folder in your own computer to which you can store items from Outlook.

You have to do this if you do not have a Microsoft Exchange Server and are using Outlook on a “stand-

alone” computer. Even if you do have an Exchange Server, you can also create Personal Folders to which

you can manually store Outlook items. A Personal Folder is a file type that ends with a “.pst” file extension.

If you do not have an Exchange Server mailbox, then a Personal Folder is created when you initially

configure your e-mail accounts in Outlook. This is the folder that contains your mail (Inbox) and other items.

If you use a Personal Folder for item storage, you hold the items on your computer in a folder that no one

else but you can access. You can view your folders by clicking the “Folder List” within the Navigation Bar.

You can create a personal folder in Outlook 2013:2010, by clicking the “File” tab in the Ribbon and

then clicking the “Info” command at the left side of the backstage view. To the right of that, click the

“Account Settings” button and choose the “Account Settings…” command form the button’s drop-down

menu to open the “Account Settings” dialog box. In this dialog box, click the “Data Files” tab. Then click the

“Add…” button on this tab to open the “Create or Open Outlook Data File” dialog box. Here you can

navigate to the folder where you wish to create the new personal folder and then type a name for the new

folder into the “File name:” text box. When you are finished, click the “OK” button to create the personal

folder data file. The file will then appear within the “Data Files” tab in the “Account Settings” dialog box.

When you are finished, click the “Close” button.

To create a personal folder in Outlook 2007, select “File| New| Outlook Data File…” from the Menu

Bar. This will open the “New Outlook Data File” dialog box where you can select “Office Outlook Personal

Folders File (.pst)” in the dialog box to create a new personal folder data file. Then click “OK” to continue.

Outlook 2007 will then launch the “Create or Open Outlook Data File” dialog box. Here you can navigate to

the folder where you wish to create the new personal folder and then type a name for the new folder into the

“File name:” text box. When you are finished, click the “OK” button to create the personal folder data file. At

that point the “Create Microsoft Personal Folders” dialog box will appear. Type the name for the folder as

you want it to appear in your “Folder List” by typing it into the “Name:” text box. You can also set a

password for access to the folder by typing the desired password into the “Password:” and “Verify

Password:” text boxes. Once you have set the folder settings as needed, click “OK” to save the folder.

In both versions, if you are viewing the “Folder List” in the Navigation Bar, you will note that you now

have a new item with the name that you entered appear in the Folder List. It will also have its own “Deleted

Items” folder. You can click on the folder to view the contents of the folder. You can also move your items

from other Outlook folders into this folder, if desired.

If you want to close the Personal Folder, you can simply right-click on the entry in the Folder List,

and select the “Close [Folder Name]” command from the pop-up menu that appears. This will remove the

entry from the Folder List, as well.

You can open the Personal Folder to return it to the Folder List. To do this in Outlook 2013:2010,

click the “File” tab in the Ribbon and then click the “Open & Export” command (the “Open” command in

2010) at the left side of the backstage view. To the right of that, click the “Open Outlook Data File” button.

To do this in Outlook 2007, select “File| Open| Outlook Data File…” from the Menu Bar. At that point in both

versions the “Open Outlook Data File” dialog box will appear, allowing you to navigate to the folder where

you saved the Personal Folder. Click it to select it, and then click the “OK” button to open the Personal

Folder. This will place the personal folder icon back into your Folder List.

To delete a Personal Folder, first make sure the folder is closed in Outlook. If using Outlook, exit

Outlook- as you will not be able to delete the folder while Outlook is running. Then use the Windows system

to navigate to the folder into which you saved the Personal Folder. Click it to select it, and press “Delete” on

your keyboard to send the folder to your computer’s Recycle Bin.Sa
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Personal & Private Folders

11.2- Setting AutoArchiving for Folders:

With all Outlook folders you can set

AutoArchiving options. AutoArchiving allows you to

automatically move messages from the specified

folder to an archive folder or delete them from your

specified folders, after a set period of time has

elapsed. AutoArchiving reduces the number of items

that Outlook will have to process when it opens a

folder. It also reduces the amount of needed storage

space in the Exchange Server for item storage.

AutoArchiving will also perform this automatically,

reducing the amount of time that you must spend

manually archiving items.

To set AutoArchiving on a folder, you need to

view its properties. You can right-click on the folder for

which you wish to set AutoArchiving, and then select

“Properties” from the pop-up menu that appears to

access the folder’s properties dialog box. Here, you

can click the “AutoArchive” tab to set the

AutoArchiving features of the folder.

You have three options that you can set: “Do

not archive items in this folder,” “Archive items in this

folder using the default settings,” or “Archive this folder

using these settings:.” If you want to set the default

AutoArchiving behavior, click the “Default Archive

Settings…” button to launch the “AutoArchive” dialog

box. Here you can set how often you wish to archive by changing the number in the “Run AutoArchive every

X days” checkbox. You can also check or uncheck whether you want a “Prompt before AutoArchive runs.”

In the “During AutoArchive:” section, set any other default options for AutoArchiving you want. You

can choose to turn off or on the ability to “Delete expired items (e-mail folders only),” “Archive or delete old

items,” and “Show archive folder in folder list.” In the “Default folder settings for archiving” section, you can

set the duration of time in the “Clean out items older than” line. Then choose what to do with the old items.

You can either move them to a Personal Folder file, or just permanently delete them by choosing whichever

option you want. If you do choose to move them, click the “Browse…” button and select the Personal Folder

that you want to use to store the old items. When you are finished setting the AutoArchiving defaults, you

can apply them to all of the folders in Outlook by clicking the “Apply these settings to all folders now” button.

You can simply set the defaults by clicking “OK.”

If you selected the “Archive this folder using these settings:” choice on the AutoArchive tab, you can

then specify when to clean the folder, and what to do with the old items, just as you did in the defaults.

However, these setting would only affect the current folder. When you are done, click “OK” to set the

AutoArchiving properties for the selected folder.
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Personal & Private Folders

11.3- Creating Private Folders:

Private Folders are simply additional folders that you can create within your storage folder

(exchange mailbox or .pst file) for organizational purposes. To create a Private Folder in Outlook

2013:2010, click the “Folder” tab in the Ribbon, and then click the “New Folder” button in the “New” group.

To create a Private Folder in Outlook 2007, select “File| New| Folder…” from the Menu Bar.

In either version, you should see the “Create New Folder” dialog box appear. In this dialog box you

must type in a name for your new folder in the “Name:” text box. Next, you must use the drop-down menu

for “Folder contains:” to select what type of Outlook items will be stored in that folder. Finally, select where

to place the new folder in the folder list from the “Select where to place the new folder:” navigation list. You

can click the “Mailbox” folder at the top of the list to add it to your mailbox with your other common folders.

When you have finished, click “OK.” This will place the new private folder into the place in the Folder List

that you selected.

In the future, if you wish to delete your Private Folder, just right-click on the folder in the Folder List

within the Navigation Bar and select the “Delete Folder” command from the pop-up menu that appears. You

can then click “Yes” to the prompt that asks you if you wish to move it to the Deleted Items folder in order to

delete it.

11.4- Creating Search Folders:

Search Folders are a great way to quickly find messages within your Outlook mail folders that match

a criteria that you set. When you create a search folder, the criteria for which you are searching for is saved

with the folder itself. Therefore, every time you open the folder, it searches for all of the Outlook messages

that match the associated folder search criteria and then automatically displays these messages. Note that

you can only create search folders for the “Mail” folders within Outlook.

If using Outlook 2010:2013, you can create a new search folder by clicking the “New Search Folder”

button within the “New” button group on the “Folder” tab within the Ribbon when viewing your “Mail” folders.

If using Outlook 2007, select “File| New| Search Folder..” from the Menu Bar. At that point, the “New Search

Folder” dialog box will appear onscreen. You can select one of the search criteria from the listing shown

and then enter the criteria that you want to search for into the criteria selection section at the bottom of this

dialog box. Note that the criteria selection will change depending on which search criteria you selected. You

can then select within which folder you want to search for messages from the “Search mail in” drop-down

menu. Then click the “OK” button to create the new search folder within your Folder Pane.

If you select the “Custom” choice from the “New Search Folder” dialog box, then when you click the

“Choose…” button at the bottom of the dialog box, you will launch the “Custom Search Folder” dialog box.

Type a name for the new folder into the “Name” field. Then click the “Criteria” button to open the “Search

Folder Criteria” dialog box where you can specify the criteria for which you want to search, and then click

the “OK” button when you are finished. You can then click the “Browse…” button within the “Custom Search

Folder” dialog box to open a “Select Folder(s)” dialog box where you can check the names of the folders

within which you want to search for messages that match the criteria that you just specified. Then click the

“OK” button to return to the “Custom Search Folder” dialog box. Then click the “OK” button to return to the

“New Search Folder” dialog box. At this point, you can click the “OK” button to add the new search folder to

your Folder Pane.

After you have created a search folder, you can then select the search folder within the Folder Pane

at any point in the future to always find the messages within the folder or folders that you selected to search

that match the criteria that you specified.Sa
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ACTIONS-

Personal & Private Folders
CREATING A PERSONAL FOLDER (.PST FILE):

1. You can create a personal folder in Outlook 2013:2010, by clicking the “File” tab in the Ribbon and then 

clicking the “Info” command at the left side of the backstage view.

2. To the right of that, you then click the “Account Settings” button and choose the “Account Settings…” 

command form the button’s drop-down menu to open the “Account Settings” dialog box.

3. In this dialog box, click the “Data Files” tab. Then click the “Add…” button on this tab to open the “Create 

or Open Outlook Data File” dialog box.

4. Here you can navigate to the folder where you wish to create the new personal folder and then type a 

name for the new folder into the “File name:” text box. When you are finished, click the “OK” button to 

create the personal folder data file.

5. The file will then appear within the “Data Files” tab in the “Account Settings” dialog box. When you are 

finished, click the “Close” button.

6. To create a personal folder in Outlook 2007, select “File| New| Outlook Data File…” from the Menu Bar.

7. This will open the “New Outlook Data File” dialog box where you can select “Office Outlook Personal 

Folders File (.pst)” in the dialog box to create a new personal folder data file. Then click “OK” to 

continue.

8. Outlook 2007 will then launch the “Create or Open Outlook Data File” dialog box. Here you can navigate 

to the folder where you wish to create the new personal folder and then type a name for the new folder 

into the “File name:” text box. When you are finished, click the “OK” button to create the personal folder 

data file.

9. At that point the “Create Microsoft Personal Folders” dialog box will appear. Type the name for the 

folder as you want it to appear in your “Folder List” by typing it into the “Name:” text box.

10. You can also set a password for access to the folder by typing the desired password into the 

“Password:” and “Verify Password:” text boxes.

11. Once you have set the folder settings as needed, click “OK” to save the folder.

12. In both versions, if you are viewing the “Folder List” in the Navigation Bar, you will note that you now 

have a new item with the name that you entered appear in the Folder List. It will also have its own 

“Deleted Items” folder. You can click on the folder to view the contents of the folder. You can also move 

your items from other Outlook folders into this folder, if desired.

13. If you want to close the Personal Folder, you can simply right-click on the entry in the Folder List, and 

select the “Close [Folder Name]” command from the pop-up menu that appears. This will remove the 

entry from the Folder List, as well.

14. You can open the Personal Folder to return it to the Folder List. To do this in Outlook 2013:2010, click 

the “File” tab in the Ribbon, and then click the “Open & Export” command (the “Open” command in 

2010) at the left side of the backstage view. To the right of that, click the “Open Outlook Data File” 

button. To do this in Outlook 2007, select “File| Open| Outlook Data File…” from the Menu Bar.

15. At that point in both versions the “Open Outlook Data File” dialog box will appear, allowing you to 

navigate to the folder where you saved the Personal Folder. It will appear in the white list box of files 

and folders in the dialog box.

16. Click it to select it, and then click the “OK” button to open the Personal Folder. This will place the 

personal folder icon back into your Folder List.

17. To delete a Personal Folder, first make sure the folder is closed in Outlook. If using Outlook, exit 

Outlook- as you will not be able to delete the folder while Outlook is running.

18. Then use the Windows system to navigate to the folder into which you saved the Personal Folder. Click 

it to select it, and press “Delete” on your keyboard to send the folder to your computer’s Recycle Bin.Sa
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ACTIONS-

Personal & Private Folders
SETTING AUTOARCHIVING FOR FOLDERS:

1. To set AutoArchiving on a folder, you need to view its properties. You can right-click on the folder for 

which you wish to set AutoArchiving, and then select “Properties” from the pop-up menu that appears to 

access the folder’s properties dialog box. Here, you can click the “AutoArchive” tab to set the 

AutoArchiving features of the folder.

2. You have three options that you can set: “Do not archive items in this folder,” “Archive items in this 

folder using the default settings,” or “Archive this folder using these settings:.”

3. If you want to set the default AutoArchiving behavior, click the “Default Archive Settings…” button to 

launch the “AutoArchive” dialog box. Here you can set how often you wish to archive by changing the 

number in the “Run AutoArchive every X days” checkbox.

4. You can also check or uncheck whether you want a “Prompt before AutoArchive runs.”

5. In the “During AutoArchive:” section, set any other default options for AutoArchiving you want. You can 

choose to turn off or on the ability to “Delete expired items (e-mail folders only),” “Archive or delete old 

items,” and “Show archive folder in folder list.”

6. In the “Default folder settings for archiving” section, you can set the duration of time in the “Clean out 

items older than” line. Then choose what to do with the old items. You can either move them to a 

Personal Folder file, or just permanently delete them by choosing whichever option you want. If you do 

choose to move them, click the “Browse…” button and select the Personal Folder that you want to use 

to store the old items.

7. When you are finished setting the AutoArchiving defaults, you can apply them to all of the folders in 

Outlook by clicking the “Apply these settings to all folders now” button. Alternately, you can simply set 

the defaults by clicking “OK.”

8. If you selected the “Archive this folder using these settings:” choice on the AutoArchive tab, you can 

then specify when to clean the folder, and what to do with the old items, just as you did in the defaults. 

However, these setting would only affect the current folder.

9. When you are done, click “OK” to set the AutoArchiving properties for the selected folder.

CREATING A PRIVATE FOLDER:

1. To create a Private Folder in Outlook 2010, click the “Folder” tab in the Ribbon, and then click the “New 

Folder” button in the “New” group. To create a Private Folder in Outlook 2007, select “File| New| 

Folder…” from the Menu Bar.

2. In either version, you should see the “Create New Folder” dialog box appear. In this dialog box you must 

type in a name for your new folder in the “Name:” text box.

3. Next, you must use the drop-down menu for “Folder contains:” to select what type of Outlook items will 

be stored in that folder.

4. Finally, select where to place the new folder in the folder list from the “Select where to place the new 

folder:” navigation list. You can click the “Mailbox” folder at the top of the list to add it to your mailbox 

with your other common folders.

5. When you have finished, click “OK.” This will place the new private folder into the place in the Folder 

List that you selected.

6. In the future, if you wish to delete your Private Folder, just right-click on the folder in the Folder List 

within the Navigation Bar and select the “Delete Folder” command from the pop-up menu.

7. You can then click “Yes” to the prompt that asks you if you wish to move it to the Deleted Items folder in 

order to delete it.Sa
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ACTIONS-

Personal & Private Folders
CREATING SEARCH FOLDERS:

1. If using Outlook 2010:2013, you can create a new search folder by clicking the “New Search Folder” 

button within the “New” button group on the “Folder” tab within the Ribbon when viewing your “Mail” 

folders.

2. If using Outlook 2007, select “File| New| Search Folder..” from the Menu Bar.

3. At that point, the “New Search Folder” dialog box will appear onscreen. You can select one of the 

search criteria from the listing shown and then enter the criteria that you want to search for into the 

criteria selection section at the bottom of this dialog box. Note that the criteria selection will change 

depending on which search criteria you selected.

4. You can then select within which folder you want to search for messages from the “Search mail in” drop-

down menu.

5. Then click the “OK” button to create the new search folder within your Folder Pane.

6. If you select the “Custom” choice from the “New Search Folder” dialog box, then when you click the 

“Choose…” button at the bottom of the dialog box, you will launch the “Custom Search Folder” dialog 

box.

7. Type a name for the new folder into the “Name” field. Then click the “Criteria” button to open the 

“Search Folder Criteria” dialog box where you can specify the criteria for which you want to search, and 

then click the “OK” button when you are finished.

8. You can then click the “Browse…” button within the “Custom Search Folder” dialog box to open a 

“Select Folder(s)” dialog box where you can check the names of the folders within which you want to 

search for messages that match the criteria that you just specified.

9. Then click the “OK” button to return to the “Custom Search Folder” dialog box.

10. Then click the “OK” button to return to the “New Search Folder” dialog box.

11. At this point, you can click the “OK” button to add the new search folder to your Folder Pane.

12. After you have created a search folder, you can then select the search folder within the Folder Pane at 

any point in the future to always find the messages within the folder or folders that you selected to 

search that match the criteria that you specified.
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EXERCISES-

Personal & Private Folders
Purpose:

1. To be able to create a Private Folder in Outlook.

Exercises:

1. Open Outlook.

2. Click the “Folder List” icon within the Navigation Bar to display the folder list.

3. If using Outlook 2013:2010, click the “New Folder” button in the “New” group on the “Folder” tab in

the Ribbon. If using Outlook 2007, select “File| New| Folder…” from the Menu Bar.

4. In the “Create New Folder” dialog box, type “Private Folder” in the “Name:” text box.

5. Click the “Mailbox” folder at the top of the list in the “Select where to place the folder:” list box.

6. Click “OK.”

7. The “Private Folder” should appear in the Folder List.

8. Right-click on the “Private Folder” icon in the Folder List.

9. Select the “Delete Private Folder” command from the pop-up menu that appears.

10. Click “Yes” to send it to the Deleted Items folder.

11. Right-click the “Deleted Items” icon in the Folder List.

12. Select the “Empty Folder” command (“Empty Deleted Items Folder” command in 2007) from the pop-

up menu that appears.

13. Assuming that your “Deleted Items” folder does not contain any items that you wish to recover, click

“Yes” to permanently delete the contents of the Deleted Items folder. If you are unsure, click “No.”

14. Click the “X” button in the upper-right corner of the application window to exit Outlook.
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12.1- Creating and Using Notes

CHAPTER 12-

Notes
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12.1- Creating and Using Notes:

You use notes to create little “post-it” reminders for activities or tasks that are too small to block into

your calendar schedule, but that you must remember to do. These notes will go into your “Notes” folder in

your Outlook mailbox. Like the Journal, the Notes feature of Outlook 2013 is being deprecated. You can

only access the Notes folder in Outlook 2013 by clicking the “Folders” button within the Navigation Bar and

then selecting the “Notes” folder within the Folder Pane. Also, the “Notes and Journal” options within the

“Outlook Options” dialog box has been removed for Outlook 2013. You also cannot change the attributes of

notes within Outlook 2013 as you could in previous versions of Outlook. In Outlook 2010:2007, you can

change the color, size and font of the note. In all versions of Outlook, Notes will appear with the time/date

stamp of when they were created or last modified. Notes can be deleted, copied, forwarded and moved.

To view the Notes folder, click the “Folders” or “Folder List” button within the Navigation Bar and

then select the “Notes” folder within the Folder Pane. The Notes folder shows any notes that you have

created or received. You can double-click on a note to view it in its own “Note” window. You can close this

window by clicking the “X” in the upper right corner of the Note.

To create a new note, click the “New Note” button in the “New” group on the “Home” tab in the

Ribbon if using Outlook 2013:2010. If using Outlook 2007, select “File| New| Note” from the Menu Bar. That

will create a new note into which you can immediately type your information. You can then close the note

when finished to add it to the Notes folder. To delete a note, right-click it within the “Notes” folder and

choose “Delete” from the pop-up menu. To forward a note to others as an attachment in an e-mail, right-

click the note within the Notes folder and select “Forward” from the pop-up menu that appears. Then

address the e-mail and send it as you normally would. The note will be sent as an attachment.

You can change the color of a single note by categorizing the note. To do this, open the note and

then click its note icon in the upper left corner of its Title Bar. Select the “Categorize” command from the

drop-down menu that appears, and then choose the color category that you want to use by selecting one

from the list of colors in the side menu that appears.

You cannot set any options for notes created in Outlook 2013. New notes that you create will have a

default color of yellow, a default size of medium, a default font of 11 point Calibri, and display the date and

time that the note was last modified.

To set note options in Outlook 2010, click the “File” tab in the Ribbon and then click the “Options”

command at the left side of the backstage view to open the “Outlook Options” dialog box. Click the “Notes

and Journal” category in this dialog box. In the “Notes options” category, use the “Default color” drop-down

to choose a default note color. Then use the “Default size:” drop-down to choose a default note size. You

can click the “Font…” button to open the “Font” dialog box to select a default font to use for your notes, and

then click the “OK” button to apply it. To include the date and time that the note was last modified, ensure

there is a checkmark in the “Show date and time that the Note was last modified” checkbox. When finished,

click the “OK” button in the “Outlook Options” window to set your new note default properties.

To set note options in Outlook 2007, select “Tools| Options…” from the Menu Bar to open the

“Options” dialog box. Click the “Preferences” tab and then click the “Note Options…” button to launch the

“Note Options” dialog box. Use the “Color:” drop-down to set the default note color. Use the “Size:” drop-

down to set the default note size. Click the “Font…” button to open the “Font” dialog box to set a default

note font to use, and then click the “OK” button to apply it. Then click “OK” in the “Note Options” dialog box

to set your new note defaults. On the “Other” tab in the “Options” dialog box, click the “Advanced Options…”

button to launch the “Advanced Options” dialog box. In the “Appearance Options” dialog box, you can check

or uncheck the checkbox for “When viewing Notes, show time and date” to add or remove the Date/Time

stamp. Then click “OK” in the “Options” dialog box to set the default note options.
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ACTIONS-

Notes
CREATING AND USING NOTES:

1. To view the Notes folder, click the “Folders” or “Folder List” button within the Navigation Bar and then 

select the “Notes” folder within the Folder Pane.

2. You can double-click on a note to view it in its own “Note” window.

3. You can close this window by clicking the “X” in the upper right corner of the Note.

4. To create a new note, click the “New Note” button in the “New” group on the “Home” tab in the Ribbon if 

using Outlook 2013:2010.

5. To create a new note in Outlook 2007, select “File| New| Note” from the Menu Bar.

6. You can immediately type your information into the new note that appears.

7. You can close the note by clicking the “X” in its upper-right corner to add it to the Notes folder.

8. To delete a note, right-click it within the “Notes” folder and choose “Delete” from the pop-up menu.

9. To forward a note as an attachment in an e-mail, right-click the note that you want to forward within the 

Notes folder and select “Forward” from the pop-up menu that appears.

10. Address the e-mail and send it as you normally would. The note will be sent as an attachment.

11. To categorize a note, open the note and then click its note icon in the upper left corner of its Title Bar.

12. Select the “Categorize” command from the drop-down menu that appears, and then choose the color 

category that you want to use by selecting one from the list of colors in the side menu that appears.

13. You cannot set any options for notes created in Outlook 2013. New notes that you create will have a 

default color of yellow, a default size of medium, a default font of 11 point Calibri, and display the date 

and time that the note was last modified.

14. To set note options in Outlook 2010, click the “File” tab in the Ribbon and then click the “Options” 

command at the left side of the backstage view to open the “Outlook Options” dialog box.

15. Click the “Notes and Journal” category in this dialog box.

16. In the “Notes options” category, use the “Default color” drop-down to choose a default note color.

17. Use the “Default size:” drop-down to choose a default note size.

18. You can click the “Font…” button to open the “Font” dialog box to select a default font to use for your 

notes, and then click the “OK” button to apply it.

19. To include the date and time that the note was last modified, ensure there is a checkmark in the “Show 

date and time that the Note was last modified” checkbox.

20. When finished, click the “OK” button in the “Outlook Options” window.

21. To set note options in Outlook 2007, select “Tools| Options…” from the Menu Bar to open the “Options” 

dialog box.

22. Click the “Preferences” tab and then click the “Note Options…” button to launch the “Note Options” 

dialog box.

23. Use the “Color:” drop-down to set the default note color.

24. Use the “Size:” drop-down to set the default note size.

25. Click the “Font…” button to open the “Font” dialog box to set a default note font to use, and then click 

the “OK” button to apply it.

26. Then click “OK” in the “Note Options” dialog box to set your new note defaults.

27. On the “Other” tab in the “Options” dialog box, click the “Advanced Options…” button to launch the 

“Advanced Options” dialog box.

28. In the “Appearance Options” dialog box, you can check or uncheck the checkbox for “When viewing 

Notes, show time and date” to add or remove the Date/Time stamp.

29. Then click “OK” in the “Options” dialog box to set the default note options.
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EXERCISES-

Notes
Purpose:

1. To be able to create notes in Outlook.

Exercises:

1. Open Outlook.

2. Click the “Folders” or “Folder List” button within the Navigation Bar.

3. Select the “Notes” folder within the Folder Pane that appears at the right side of the Outlook window.

4. If using Outlook 2013:2010, click the “New Note” button in the “New” group on the “Home” tab in the

Ribbon.

5. If using Outlook 2007, select “File| New| Note” from the Menu Bar.

6. Type the following into the note: “Remember that notes can help remind you to do little tasks, like

sticky notes without the clutter.”

7. Click the “X” in the upper right corner of the note to close it.

8. Right-click on the note in the Notes folder, and select “Delete” from the pop-up menu that appears to

move it to the “Deleted Items” folder.

9. Click the “X” button in the upper-right corner of the application window to exit Outlook.
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13.1- Creating Mailbox Rules

13.2- Creating Custom Mailbox Views

13.3- Handling Junk Mail

13.4- Color Categorizing

13.5- Advanced Find

CHAPTER 13-

Advanced Mailbox Options
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13.1- Creating Mailbox Rules:

A mailbox rule simply states that whenever items arrive into a mailbox that meet a specified criteria

they should then be processed by whatever the rule dictates should happen when an item of that type is

received. You can have multiple rules applied to a single mailbox. The rules will be acted upon in sequence

from top to bottom through the list of rules created for that mailbox. They can also be modified at a later

date, or deleted if they no longer apply. You can also turn them on and off without having to delete and

recreate them.

To create a mailbox rule, first select the mailbox folder for which you want to create a rule. You can

then start the “Rules Wizard” to assist you in creating the necessary rule criteria and actions that you want

the rule to perform when an item is received in the mailbox that matches the specified criteria. To access

this wizard in Outlook 2013:2010, click the “Rules” button in the “Move” group on the “Home” tab in the

Ribbon, and then select the “Manage Rules & Alerts…” command. To access this wizard in Outlook 2007,

select “Tools| Rules and Alerts…” from the Menu Bar. In either version, the “Rules and Alerts” dialog box

will then appear. Ensure that you are viewing the “E-mail Rules” tab, and then click the “New Rule…” button

in the upper left corner of that tab to launch the “Rules Wizard.”

In the “Rules Wizard,” you will need to select one of the templates from the list shown in the “Step 1:

Select a template” area. The rule description will appear in the “Step 2: Edit the rule description” section at

the bottom of the dialog box with hyperlinks indicating places that you need to click into and “fill-in-the-

blanks” in the rule template. When you are finished on this screen, click “Next >” to continue.

In the next screen, you can use the “Step 1: Select condition(s):” list at the top to check various

criteria that you will see appended to the rule below. If you started from a template, some of this is already

done, but you can add more criteria if necessary. Then click on the blue hyperlinks in the rule at the bottom

of the dialog box to “fill-in-the-blanks” in the rule. Click “Next >” to continue when you are ready.

In the next screen, you must decide what action the rule should take when it receives an item that

matches the criteria you just set. You can check the actions listed at the top of the dialog box to append

them to the rule at the bottom of the dialog box. Then click the blue hyperlinks in the bottom box to “fill-in-

the-blanks” in the rule. Click “Next >” when you are ready to continue.

In the next screen, you must decide what exceptions to the rule exist. You can check the exceptions

listed at the top of the dialog box to append them to the rule at the bottom of the dialog box. Then click the

blue hyperlinks in the bottom box to “fill-in-the-blanks” in the rule. Click “Next >” when you are ready to

continue.

In the last screen, type a name for the rule into the text box at the top of the dialog box. You can also

check or uncheck the two checkboxes for “Run this rule now on messages already in [folder name],” or

“Turn on this rule.” When you are ready to finish the rule, click the “Finish” button.

That will drop you back off in the “Rules and Alerts” dialog box on the “E-mail Rules” tab. Note that

like folder rules, you can check or uncheck the rules listed here to turn them on and off. You can also use

the “Change Rule…” drop-down button to edit a selected rule at a later point in time, if needed. You can

also click the “Delete” button to delete a selected rule, if necessary. When you are finished, click “OK” to set

the e-mail rules.

Advanced Mailbox Options
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13.2- Creating Custom Mailbox Views:

You can create your own custom view of folders in your Outlook mailbox. If using Outlook

2013:2010, you create custom mailbox views by clicking the “View” tab in the Ribbon and then clicking the

“Change View” button in the “Current View” group. From the drop-down menu that appears, you can then

select the “Manage Views…” command. In Outlook 2007, you can do this by selecting “View| Current View|

Define Views…” from the Menu Bar.

At this point, a dialog box will appear onscreen. In Outlook 2013:2010, it is called the “Manage All

Views” dialog box. In Outlook 2007, it is called the “Custom View Organizer.” In both versions, it simply

displays all of the available views and their associated settings. Here you can select any view that you want

and then modify it, or reset modifications made to one of the selected views. You can also create, edit or

delete your own custom views that you have created using this dialog box.

To create a new view, just click the “New…” button to the right of the dialog box. That will open the

“Create a New View” dialog box where you type a name for the new view into the “Name of new view:” text

box. Below that, select what type of view you want to create: “Table,” “Timeline,” “Card,” “Business Card,”

“Day/Week/Month,” or “Icon.”

Once you selected your base folder view, select who will have this view available to them: “This

folder, visible to everyone,” “This folder, visible only to me,” or “All Mail and Post folders.” Then click “OK” to

launch another dialog box where you can further customize the view. In Outlook 2013:2010, this dialog box

is called the “Advanced View Settings” dialog box. In Outlook 2007, it is called the “Customize View” dialog

box. However, the options that you have for customizing the view are the same for both versions. The

dialog box has seven buttons that you can click to set options for your view. Based on your base view type,

however, not all of the buttons will necessarily be available.

Clicking the “Columns…” button (“Fields…” button in Outlook 2007) launches the “Show Columns”

dialog box (“Show Fields” dialog box in Outlook 2007). Here you can use the drop-down in the upper left

corner to choose which set of fields you wish to see appear in the left list. To move an available field into

your new view, select it in the left list and then click the “Add” button in the middle of this dialog box to add it

to the list at the right. You can then select the field from the list at the right and reorganize its position by

selecting it, and clicking the “Move Up” and “Move Down” buttons until it is in the place you desire. Click

“OK” when you are done adding and organizing the fields in your view.

Clicking the “Group By…” button launches the “Group By” dialog box. Here you can use the drop-

down under “Group items by” to select a field by which you can group items in your view. This is usually

only used for the “table” style view, as it will group the same values in the selected field or fields into

expandable and collapsible groups within your table view. You can select up to four fields by which to

group. You can also set whether they will be grouped in “Ascending” (A-Z, 1-9) order or “Descending” (Z-A,

9-1) order by selecting the desired sorting option at the right end of each grouped field. When you are done

here, you can click “OK” to set the grouping for your view.

Clicking the “Sort…” button launches the “Sort” dialog box. Here you can use the drop-down

available under the “Sort items by” and “Then by” sections to indicate by which field(s) you want to sort the

view. You can sort by up to four fields, and they can be sorted in either “Ascending” order or “Descending”

order by selecting the appropriate option at the right end of each field. When you are done here, you can

click “OK” to set the sorting for your view.

Clicking the “Filter…” button launches the “Filter” dialog box. This dialog box consists of four tabs:

“Messages,” “More Choices,” “Advanced,” and “SQL.” You click on the tab that you want to use to set

criteria that will include or exclude certain items in your view. On the “Messages” tab, you can choose

criteria that will allow you to filter by various common e-mail fields. On the “More Choices” tab, you can

choose criteria that will allow you to filter by assigned categories, message statuses, message option

Advanced Mailbox Options
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13.2- Creating Custom Mailbox Views (cont.):

settings, and other more advanced filtering possibilities. On the “Advanced” tab, you can use the “Field”

drop-down to select from any of the available fields in Outlook that you want to use as a filter. Then use the

“Condition” drop-down to select a comparison condition, and if needed, type the value to which you want to

compare the field’s value in the last text box. That will add it to the list box above. Clicking the “SQL” tab

allows you to create a statement using Structured Query Language to select which items you wish to see.

You can do this if you are familiar with how SQL is used in the Outlook application. When you are done

creating any filters necessary for your view, click the “OK” button to set the desired filters for your view.

Clicking the “Other Settings…” button launches the “Other Settings” dialog box. Here you can adjust

the font display for the items in your view. The content available here will change depending on the style of

view you are trying to create. Make any adjustments that you wish, and then click the “OK” button to apply

them to your new view.

Clicking the “Conditional Formatting…” button (“Automatic Formatting…” button in Outlook 2007)

launches the “Conditional Formatting” dialog box (“Automatic Formatting” dialog box in Outlook 2007). Here

you can set new rules to apply a default formatting to items that meet a given criteria. There are some rules

already in place in this dialog box, and you can add more. To add a new rule, click the “Add” button at the

right side of this dialog box. It will add a new rule to the list. Type a name for the rule into the “Name:” text

box. Then click the “Font…” button to set the font formatting that the item should use when the condition

that you are about to specify is met. Click “OK” in the “Font” dialog box to set the font. You then click the

“Condition…” button to set up the filter that, when met, applies the formatting you selected. You have the

same choices available here as you do when you set the filter for the view. After setting the filter, click “OK”

to apply it. Then click “OK” again when finished setting your conditional formatting.

If using a table view in Outlook, you can click the “Format Columns…” button to specify a display

format for each field that you have in your view. Just select the name of the field whose display you wish to

modify from the “Available fields:” list at the left side of this dialog box, and then change its settings at the

right side of the dialog box. When you are finished, click “OK” to apply the changes to your view.

When you are satisfied with all of the view’s settings, click “OK” in the “Advanced View Settings”

dialog box (“Customize View” dialog box in 2007) to return to the “Manage All Views” dialog box (“Custom

View Organizer” dialog box in 2007). You will now see the name of your view shown in the list of views

available in the dialog box. To apply your view, just click on its name to select it from the list, and click the

“Apply View” button at the bottom of the dialog box.

If using Outlook 2013:2010, you can also select the name of the view from the drop-down menu that

appears when you click the “Change View” drop-down button in the “Current View” group on the “View” tab

in the Ribbon. If using Outlook 2007, it will also appear in the side menu that is shown when you select

“View| Current View” from the Menu Bar.

Note that if you want to modify a view that you have created, you can select the name of the view

from the listing shown in the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007),

and then click the “Modify…” button at the right side of the dialog box. In this same area, you can also select

the name of a custom view that you have created, and then click the “Delete” button to delete it if you will no

longer need to use the view.

When you have finished using the “Manage All Views” dialog box (“Custom View Organizer” dialog

box in 2007), click the “Close” button at the bottom of the dialog box to return to the mailbox folder view.

Advanced Mailbox Options
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13.3- Handling Junk Mail:

To block junk e-mail, you must first open the folder to filter for junk e-mail. If using Outlook

2013:2010, then click the “Junk” drop-down button in the “Delete” group on the “Home” tab in the Ribbon

and select the “Junk E-mail Options…” command from the button’s drop-down menu. If using Outlook 2007,

select “Actions| Junk E-mail| Junk E-mail Options…” from the Menu Bar.

In either version at that point, you will see the “Junk E-mail Options” dialog box appear. On the

“Options” tab, select the option button that corresponds to how you wish Outlook to handle suspected junk

mail. Note that you can elect to delete suspected junk e-mail versus moving it into the “Junk E-mail” folder in

your folder list by checking the checkmark at the bottom of this tab. Be careful of doing this if you have a

very restrictive junk mail filter applied, as it could then potentially delete legitimate messages that Outlook

suspects may by junk mail.

If you click the “Safe Senders” tab, you can click “Add…” at the right side of this tab to add an e-mail

address or domain name into the “Add address or domain” dialog box. The “Safe Senders” list is the list of

people from whom you always wish to receive e-mail in Outlook. Mail from these addresses or domains will

never be treated as junk mail by Outlook. You can then click the “OK” button when you have finished.

On the “Safe Recipients” tab, you can click “Add…” at the right side of this tab to add an e-mail

address or domain name into the “Add address or domain” dialog box. The “Safe Recipients” list is the list

of people to whom you always wish to send e-mail in Outlook. Mail sent to these addresses or domains will

never be treated as junk mail by Outlook. You can then click the “OK” button when you have finished.

On the “Blocked Senders” tab, you click “Add…” at the right side of this tab to add an e-mail address

or domain name in the “Add address or domain” dialog box. The “Blocked Senders” list is the list of people

from whom you always wish to block e-mail in Outlook. Mail from these addresses or domains will always

be treated as junk mail by Outlook. You can then click the “OK” button when you have finished.

When you have finished setting the desired junk mail options, click “OK” in the “Junk E-mail Options”

dialog box to set the new rules in place for the selected mail folder.

In the future, when you receive an e-mail from an address which you wish to add to either the “Safe

Senders,” “Safe Recipients,” or “Blocked Senders” tabs, you can easily do that by right-clicking the piece of

mail in your mailbox from the desired sender first. Then roll over the “Junk” command in the pop-up menu

that appears. In the side menu that then appears, select to which e-mail list you wish to add the e-mail

address of the sender.

Advanced Mailbox Options

13.4- Color Categorizing:

You can assign any items in your Outlook folders to one of the available color categories. To do this,

you simply open the Outlook folder that contains the item or items that you want to assign to one or more

color categories. Then select the item or items in that folder which you would like to categorize.

If using Outlook 2013:2010, click the “Categorize” button in the “Tags” group on the “Home” tab in

the Ribbon, and then select the color category that you want to apply to the selected item or items. If using

Outlook 2007, click the “Categorize” button in the Standard toolbar and then click on the color category that

you want to apply to the selected item or items.
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Advanced Mailbox Options

13.5- Advanced Find:

With Outlook, you can do an advanced find in order to find all Outlook items that belong to a

particular category. You could also use the advanced find feature to find items in Outlook using many other

types of filters as well.

To perform an advanced find in Outlook 2013:2010, click into the “Instant Search” text box in order

to display the “Search” tab of the “Search Tools” contextual tab within the Ribbon. Then click the “Search

Tools” drop-down button in the “Options” group on the “Search” tab of the “Search Tools” contextual tab in

the Ribbon. From the drop-down menu that appears, select the “Advanced Find…” command to open the

“Advanced Find” dialog box. To perform an advanced find in Outlook 2007, select “Tools| Instant Search|

Advanced Find…” from the Menu Bar.

In the “Advanced Find” dialog box that appears in either version, use the “Look” drop-down at the

very top of the dialog box to select the type of Outlook items you are looking for. You can also click the

“Browse…” button in the upper right corner to launch the “Select Folder(s)” dialog box, where you can check

which folders you want to look within. If you do that, click “OK” when finished to return to the “Advanced

Find” dialog box.

Next you will use either the “Messages” (or whichever item type you selected from the “Look ” drop-

down), “More Choices,” or “Advanced” tab to create the filters by which you wish to search for matching

items.

After you have created the necessary filters, click the “Find Now” button to show the result set of the

search in a window at the bottom of the dialog box. You can then double-click on the items to open them

and access them like you would in your Inbox folder.

When you are finished, click the “X” in the upper right corner of the “Advanced Find” window to close

it and return to Outlook.
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ACTIONS-

Advanced Mailbox Options
CREATING MAILBOX RULES:

1. To create a mailbox rule in Outlook 2013:2010, click the “Rules” button in the “Move” group on the 

“Home” tab in the Ribbon, and then select the “Manage Rules & Alerts…” command. To create a 

mailbox rule in Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar. In either version, 

the “Rules and Alerts” dialog box will then appear. Ensure that you are viewing the “E-mail Rules” tab, 

and then click the “New Rule…” button in the upper left corner of that tab to launch the “Rules Wizard.”

2. In the “Rules Wizard,” you will need to select one of the templates from the list shown in the “Step 1: 

Select a template” area. The rule description will appear in the “Step 2: Edit the rule description” section 

at the bottom of the dialog box with hyperlinks indicating places that you need to click into and “fill-in-

the-blanks” in the rule template. When you are finished on this screen, click “Next >” to continue.

3. In the next screen, you can use the “Step 1: Select condition(s):” list at the top to check various criteria 

that you will see appended to the rule below. If you started from a template, some of this is already 

done, but you can add more criteria if necessary. Then click on the blue hyperlinks in the rule at the 

bottom of the dialog box to “fill-in-the-blanks” in the rule. Click “Next >” to continue when you are ready.

4. In the next screen, you must decide what action the rule should take when it receives an item that 

matches the criteria you just set. You can check the actions listed at the top of the dialog box to append 

them to the rule at the bottom of the dialog box. Then click the blue hyperlinks in the bottom box to “fill-

in-the-blanks” in the rule. Click “Next >” when you are ready to continue.

5. In the next screen, you must decide what exceptions to the rule exist. You can check the exceptions 

listed at the top of the dialog box to append them to the rule at the bottom of the dialog box. Then click 

the blue hyperlinks in the bottom box to “fill-in-the-blanks” in the rule. Click “Next >” when finished.

6. In the last screen, type in a name for the rule in the text box at the top of the dialog box. You can also 

check or uncheck the two checkboxes for “Run this rule now on messages already in [folder name],” or 

“Turn on this rule.” When you are ready to finish the rule, click the “Finish” button.

7. That will drop you back off in the first “Rules and Alerts” dialog box. Note that like folder rules, you can 

check or uncheck the rules listed here to turn them on and off.

8. You can also use the “Change Rule…” drop-down button to edit the selected rule at a later point in time.

9. You can click the “Delete” button to delete the selected rule, when necessary.

10. When you are finished here, click “OK” to set the rules.

CREATING CUSTOM MAILBOX VIEWS:

1. If using Outlook 2013:2010, you create custom mailbox views by clicking the “View” tab in the Ribbon 

and then clicking the “Change View” button in the “Current View” group.

2. From the drop-down menu that appears, you can then select the “Manage Views…” command.

3. In Outlook 2007, you can do this by selecting “View| Current View| Define Views…” from the Menu Bar.

4. At this point in either version, a dialog box will appear onscreen. In Outlook 2013:2010, it is called the 

“Manage All Views” dialog box. In Outlook 2007, it is called the “Custom View Organizer.” In both 

versions, it simply displays all of the available views and their associated settings.

5. To create a new view, just click the “New…” button to the right of the dialog box.

6. That will open the “Create a New View” dialog box where you type a name for the new view into the 

“Name of new view:” text box.

(cont’d.)Sa
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ACTIONS-

Advanced Mailbox Options
CREATING CUSTOM MAILBOX VIEWS- (CONT’D.):

7. Below that, select what type of view you want to create: “Table,” which lays out the information in a table 

like the Inbox folder does by default; “Timeline,” which shows items in a timeline view like the Journal 

folder does by default; “Card,” which lays out the information in a card view like the Contacts folder does 

in the “Address Cards” view; “Business Card,” which displays information in the view using a layout like 

the one used by the “Business Card” view of the Contact folders; “Day/Week/Month,” which shows 

information in a day/week/month style like the Calendar does by default; or “Icon,” which shows icons 

for the items like your typical Windows folder does, by default.

8. Once you selected your base folder view, select who will have this view available to them: “This folder, 

visible to everyone,” “This folder, visible only to me,” or “All Mail and Post folders.” Then click “OK” to 

launch another dialog box where you can further customize the view. In Outlook 2013:2010, this dialog 

box is called the “Advanced View Settings” dialog box. In Outlook 2007, it is called the “Customize 

View” dialog box. However, the options that you have for customizing the view are the same for both 

versions. Clicking the “Columns…” button (“Fields…” button in Outlook 2007) launches the “Show 

Columns” dialog box (“Show Fields” dialog box in Outlook 2007). Here you can use the drop-down in 

the upper left corner to choose which set of fields you wish to see appear in the left list. To move an 

available field into your new view, select it in the left list and then click the “Add” button in the middle of 

this dialog box to add it to the list at the right. You can then select the field from the list at the right and 

reorganize its position by selecting it, and clicking the “Move Up” and “Move Down” buttons until it is in 

the place you desire. Click “OK” when you are done adding and organizing the fields in your view.

9. Clicking the “Group By…” button launches the “Group By” dialog box. Here you can use the drop-down 

under “Group items by” to select a field by which you can group items in your view. This is usually only 

used for the “table” style view, as it will group the same values in the selected field or fields into 

expandable and collapsible groups within your table view. You can select up to four fields by which to 

group. You can also set whether they will be grouped in “Ascending” (A-Z, 1-9) order or “Descending” 

(Z-A, 9-1) order by selecting the desired sorting option at the right end of each grouped field. When you 

are done here, you can click “OK” to set the grouping for your view.

10. Clicking the “Sort…” button launches the “Sort” dialog box. Here you can use the drop-down available 

under the “Sort items by” and “Then by” sections to indicate by which field(s) you want to sort the view. 

You can sort by up to four fields, and they can be sorted in either “Ascending” order or “Descending” 

order by selecting the appropriate option at the right end of each field. When you are done here, you 

can click “OK” to set the sorting for your view.

11. Clicking the “Filter…” button launches the “Filter” dialog box. This dialog box consists of four tabs: 

“Messages,” “More Choices,” “Advanced,” and “SQL.” You click on the tab that you want to use to set 

criteria that will include or exclude certain items in your view. On the “Messages” tab, you can choose 

criteria that will allow you to filter by various common e-mail fields. On the “More Choices” tab, you can 

choose criteria that will allow you to filter by assigned categories, message statuses, message option 

settings, and other more advanced filtering possibilities. On the “Advanced” tab, you can use the “Field” 

drop-down to select from any of the available fields in Outlook that you want to use as a filter. Then use 

the “Condition” drop-down to select a comparison condition, and if needed, type the value to which you 

want to compare the field’s value in the last text box. That will add it to the list box above. Clicking the 

“SQL” tab allows you to create a statement using Structured Query Language to select which items you 

wish to see. You can do this if you are familiar with how SQL is used in the Outlook application. When 

you are done creating any filters for your view, click the “OK” button to set the filters for your view.

(cont’d.)Sa
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ACTIONS-

Advanced Mailbox Options
CREATING CUSTOM MAILBOX VIEWS- (CONT’D.):

12. Clicking the “Other Settings…” button launches the “Other Settings” dialog box. Here you can adjust the 

font display for the items in your view. The content available here will change depending on the style of 

view you are trying to create. Make any adjustments that you wish, and then click the “OK” button to 

apply them to your new view.

13. Clicking the “Conditional Formatting…” button (“Automatic Formatting…” button in Outlook 2007) 

launches the “Conditional Formatting” dialog box (“Automatic Formatting” dialog box in Outlook 2007). 

Here you can set new rules to apply a default formatting to items that meet a given criteria. There are 

some rules already in place in this dialog box, and you can add more.

14. To add a new rule, click the “Add” button at the right side of this dialog box. It will add a new rule to the 

list. Type a name for the rule into the “Name:” text box.

15. Then click the “Font…” button to set the font formatting that the item should use when the condition that 

you are about to specify is met. Click “OK” in the “Font” dialog box to set the font.

16. You then click the “Condition…” button to set up the filter that, when met, applies the formatting you 

selected. You have the same choices available here as you do when you set the filter for the view. After 

setting the filter, click “OK” to apply it.

17. Then click “OK” again when finished setting your conditional formatting.

18. If using a table view in Outlook, you can click the “Format Columns…” button to specify a display format 

for each field that you have in your view. Just select the name of the field whose display you wish to 

modify from the “Available fields:” list at the left side of this dialog box, and then change its settings at 

the right side of the dialog box. When you are finished, click “OK” to apply the changes to your view.

19. When you are satisfied with all of the view’s settings, click “OK” in the “Advanced View Settings” dialog 

box (“Customize View” dialog box in 2007) to return to the “Manage All Views” dialog box (“Custom 

View Organizer” dialog box in 2007). You will now see the name of your view shown in the list of views 

available in the dialog box.

20. To apply your view, just click on its name to select it from the list, and click the “Apply View” button at 

the bottom of the dialog box.

21. If using Outlook 2013:2010, you can also select the name of the view from the drop-down menu that 

appears when you click the “Change View” drop-down button in the “Current View” group on the “View” 

tab in the Ribbon. If using Outlook 2007, it will also appear in the side menu that is shown when you 

select “View| Current View” from the Menu Bar.

22. Note that if you want to modify a view that you have created, you can select the name of the view from 

the listing shown in the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007), 

and then click the “Modify…” button at the right side of the dialog box.

23. In this same area, you can also select the name of a custom view that you have created, and then click 

the “Delete” button to delete it if you will no longer need to use the view.

24. When you have finished using the “Manage All Views” dialog box (“Custom View Organizer” dialog box 

in 2007), click the “Close” button at the bottom of the dialog box to return to the mailbox folder view.
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HANDLING JUNK MAIL:

1. To block junk e-mail, you must first open the folder to filter for junk e-mail.

2. If using Outlook 2013:2010, then click the “Junk” drop-down button in the “Delete” group on the “Home” 

tab in the Ribbon and select the “Junk E-mail Options…” command from the button’s drop-down menu. 

If using Outlook 2007, select “Actions| Junk E-mail| Junk E-mail Options…” from the Menu Bar.

3. In either version at that point, you will see the “Junk E-mail Options” dialog box appear. On the “Options” 

tab, select the option button that corresponds to how you wish Outlook to handle suspected junk mail.

4. Note that you can elect to delete suspected junk e-mail versus moving it into the “Junk E-mail” folder in 

your folder list by checking the checkmark at the bottom of this tab. Be careful of doing this if you have a 

very restrictive junk mail filter applied, as it could then potentially delete legitimate messages that 

Outlook suspects may by junk mail.

5. If you click the “Safe Senders” tab, you can click “Add…” at the right side of this tab to add an e-mail 

address or domain name into the “Add address or domain” dialog box. The “Safe Senders” list is the list 

of people from whom you always wish to receive e-mail in Outlook. Mail from these addresses or 

domains will never be treated as junk mail by Outlook. You can then click the “OK” button when you 

have finished.

6. On the “Safe Recipients” tab, you can click “Add…” at the right side of this tab to add an e-mail address 

or domain name into the “Add address or domain” dialog box. The “Safe Recipients” list is the list of 

people to whom you always wish to send e-mail in Outlook. Mail sent to these addresses or domains 

will never be treated as junk mail by Outlook. You can then click the “OK” button when you have 

finished.

7. On the “Blocked Senders” tab, you click “Add…” at the right side of this tab to add an e-mail address or 

domain name in the “Add address or domain” dialog box. The “Blocked Senders” list is the list of people 

from whom you always wish to block e-mail in Outlook. Mail from these addresses or domains will 

always be treated as junk mail by Outlook. You can then click the “OK” button when you have finished.

8. When you have finished setting the desired junk mail options, click “OK” in the “Junk E-mail Options” 

dialog box to set the new rules in place for the selected mail folder.

9. In the future, when you receive an e-mail from an address which you wish to add to either the “Safe 

Senders,” “Safe Recipients,” or “Blocked Senders” tabs, you can easily do that by right-clicking the 

piece of mail in your mailbox from the desired sender first.

10. Then roll over the “Junk” command in the pop-up menu that appears.

11. In the side menu that then appears, select to which e-mail list you wish to add the e-mail address of the 

sender.

COLOR CATEGORIZING:

1. You can assign any items in your Outlook folders to one of the available color categories.

2. To do this, you simply open the Outlook folder that contains the item or items that you want to assign to 

one or more color categories.

3. Then select the item or items in that folder which you would like to categorize.

4. If using Outlook 2013:2010, click the “Categorize” button in the “Tags” group on the “Home” tab in the 

Ribbon, and then select the color category that you want to apply to the selected item or items.

5. If using Outlook 2007, click the “Categorize” button in the Standard toolbar and then click on the color 

category that you want to apply to the selected item or items.Sa
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Advanced Mailbox Options
ADVANCED FIND

1. With Outlook, you can do an advanced find in order to find all Outlook items that belong to a particular 

category. You could also use the advanced find feature to find items in Outlook using many other types 

of filters as well.

2. To perform an advanced find in Outlook 2013:2010, click into the “Instant Search” text box in order to 

display the “Search” tab of the “Search Tools” contextual tab within the Ribbon. Then click the “Search 

Tools” drop-down button in the “Options” group on the “Search” tab of the “Search Tools” contextual tab 

in the Ribbon. From the drop-down menu that appears, select the “Advanced Find…” command to open 

the “Advanced Find” dialog box.

3. To perform an advanced find in Outlook 2007, select “Tools| Instant Search| Advanced Find…” from the 

Menu Bar.

4. In the “Advanced Find” dialog box that appears in either version, use the “Look” drop-down at the very 

top of the dialog box to select the type of Outlook items you are looking for.

5. You can also click the “Browse…” button in the upper right corner to launch the “Select Folder(s)” dialog 

box, where you can check which folders you want to look within. If you do that, click “OK” when finished 

to return to the “Advanced Find” dialog box.

6. Next you will use either the “Messages” (or whichever item type you selected from the “Look” drop-

down), “More Choices,” or “Advanced” tab to create the filters by which you wish to search for matching 

items.

7. After you have created the necessary filters, click the “Find Now” button to show the result set of the 

search in a window at the bottom of the dialog box. You can then double-click on the items to open them 

and access them like you would in your Inbox folder.

8. When you are finished, click the “X” in the upper right corner of the “Advanced Find” window to close it 

and return to Outlook
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EXERCISES-

Advanced Mailbox Options
Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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14.1- Using Shortcuts

14.2- Adding Additional Profiles

14.3- Adding Additional Services

14.4- Outlook Options

14.5- Using Outlook Help

CHAPTER 14-

Odds & Ends
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14.1- Using Shortcuts:

You can add shortcuts to the folders in Outlook to the “Shortcuts” group on the Navigation Bar. To

do this, first click the “Shortcuts” button in the Navigation Bar.

If using Outlook 2013:2010, then right-click the actual word “Shortcuts” shown within the Folder

Pane to display a pop-up menu of choices. Click the “New Shortcut” choice to open the “Add to Navigation

Bar” dialog box. Here you can click on the folder to which you would like to add a shortcut and then click the

“OK” button. The shortcut to the selected folder will then be added to the shortcut list.

To add a shortcut to an Outlook folder in Outlook 2007, you can simply click the “Add New Shortcut”

hyperlink shown in the Navigation Bar and then select the name of the folder to add from the “Add to

Navigation Bar” dialog box. Then click “OK.”

To delete a shortcut, simply right-click on the shortcut in this list and then select the “Delete

Shortcut” command. You can then click “Yes” in the message box that appears to delete the shortcut.

Outlook Options

14.2- Adding Additional Profiles:

You can add additional user profiles to Outlook in order to let multiple people access the same

computer but have access to different Outlook accounts. You will need to set up each profile using the

“Control Panel” feature of Windows. Within the Windows “Control Panel,” you can click the “Mail” icon to

access the mail settings. This will launch the “Mail Setup” dialog box. Here you can click the “Show

Profiles…” button to access the “Mail” dialog box.

To create a new profile, click the “Add…” button. You will need to type the name of the new profile

into the “Profile Name:” text box, and then click “OK.” That will then bring up the “Add New Account” dialog

box, where you can configure the e-mail account settings that you want to add to the designated profile. We

will look at how we can do this in the next lesson. When you are finished, you will return to the “Mail” dialog

box. In the “Mail” dialog box, note that you can also set up Outlook to prompt for the profile that it should use

at startup by selecting that option button. Then click the “OK” button when you are finished.

14.3- Adding Additional Services:

You can configure Outlook to access several different types of e-mail accounts. These may be

POP3 or SMTP mail accounts or accounts on your Exchange Server. If connecting to a internet e-mail

account, you will need to know the specific POP3 and SMTP server address information and your account

name and password. You should contact your Network Administrator or ISP to acquire this information

before attempting to configure Outlook e-mail accounts.

When you have the necessary information, if using Outlook 2013:2010, click the “File” tab in the

Ribbon, and then click the “Add Account” button that appears to the right side of the backstage view. If

using Outlook 2007, select “Tools| Account Settings…” from the Menu Bar to open the “Account Settings”

dialog box. On the “E-mail” tab, click the “New…” button. In both versions, the “Add New Account” dialog

box appears. Start by selecting the option button that corresponds to the type of e-mail account you are

trying to create. Depending on what you select here, the screens that follow will vary. However, they will all

prompt you for mail server, connection, and account information- so make sure that you have that

information ready. Once again, you can get that information from your e-mail service provider or your

network administrator. Answer any questions posed by each screen, entering the necessary information

and then clicking “Next >” to continue until you are finished. At that point, if using Outlook 2007, you can

click the “Close” button in the “Account Settings” dialog box to close it.Sa
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Outlook Options

14.4- Outlook Options:

You can change the default settings of Outlook by changing its options. We have already seen this

dialog box at various points in the tutorial, but it is worth emphasizing in its own right.

You can access the default options in Outlook 2013:2010 by clicking the “File” tab in the Ribbon and

then clicking the “Options” button to open the “Outlook Options” dialog box. In this dialog box, you can click

on a category listing at the left side in order to change any settings that then appear at the right side. When

finished, click the “OK” button to save your changes.

You can access the default settings of Outlook 2007 by selecting “Tools| Options…” from the Menu

Bar. There are seven tabs that you can use to change the settings of Outlook 2007. Make any changes that

you want to one the appropriate tabs, and click “OK” to save your changes.

14.5- Using Outlook Help:

Outlook has built-in help functionality which can greatly reduce the time and cost of technical

support. The help functionality is quite extensive. It contains a searchable database of help files for you to

read.

You can access the help in Outlook by clicking the “Microsoft Outlook Help” button. This will open

the “Outlook Help” window. Notice that this window can be closed by simply clicking the “x” in the upper

right corner of the window when you are finished using the help files.

If you wish to search through the help files for a topic, you can easily type the words for which you

wish to look into the long white text box in the toolbar at the top of this window. You can then decide where

you wish to search for the information by clicking the drop-down button next to the “Outlook Help” title in

Outlook 2013 or the “Search” button in Outlook 2010:2007, and then selecting a choice from the drop-down

menu. Once you have selected where to search, just click the “Search” button to let Outlook search for the

words or phrases that you entered.

Any matching help topics are then displayed in the “Outlook Help” window as a listing of hyperlinks.

You can click on the name of a help topic to view its content in the “Outlook Help” window. To go back to

the main listing of help topics, just click the “Back” button in the toolbar at the top of the window to return to

the list. You can then continue reading other topics, perform another search, or simply close the window if

you are finished.

Should you want to print any topic that is displayed in the “Outlook Help” window, you can do so by

just clicking the “Print” button in the toolbar at the top of the “Outlook Help” window.
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Outlook Options
USING SHORTCUTS:

1. You can add shortcuts to the folders in Outlook to the “Shortcuts” group on the Navigation Bar. To do 

this, first click the “Shortcuts” button in the Navigation Bar.

2. If using Outlook 2013:2010, then right-click the actual word “Shortcuts” shown within the Folder Pane to 

display a pop-up menu of choices. Click the “New Shortcut” choice to open the “Add to Navigation Bar” 

dialog box. Here you can click on the folder to which you would like to add a shortcut and then click the 

“OK” button. The shortcut to the selected folder will then be added to the shortcut list.

3. To add a shortcut to an Outlook folder in Outlook 2007, you can simply click the “Add New Shortcut” 

hyperlink shown in the Navigation Bar and then select the name of the folder to add from the “Add to 

Navigation Bar” dialog box. Then click “OK.”

4. To delete a shortcut, simply right-click on the shortcut in this list and then select the “Delete Shortcut” 

command. You can then click “Yes” in the message box that appears to delete the shortcut.

ADDING ADDITIONAL PROFILES:

1. You can add additional user profiles to Outlook in order to let multiple people access the same computer 

but have access to different Outlook accounts. You will need to set up each profile using the “Control 

Panel” feature of Windows.

2. Within the Windows “Control Panel,” you can click the “Mail” icon to access the mail settings. This will 

launch the “Mail Setup” dialog box.

3. Here you can click the “Show Profiles…” button to access the “Mail” dialog box.

4. To create a new profile, click the “Add…” button.

5. You will need to type the name of the new profile into the “Profile Name:” text box, and then click “OK.”

6. That will then bring up the “Add New Account” dialog box, where you can configure the e-mail account 

settings that you want to add to the designated profile. We will look at how we can do this in the next 

lesson.

7. When you are finished, you will return to the “Mail” dialog box. In the “Mail” dialog box, note that you can 

also set up Outlook to prompt for the profile that it should use at startup by selecting that option button.

8. Then click the “OK” button when you are finished.

ADDING ADDITIONAL SERVICES:

1. If using Outlook 2013:2010, click the “File” tab in the Ribbon, and then click the “Add Account” button 

that appears to the right side of the backstage view. If using Outlook 2007, select “Tools| Account 

Settings…” from the Menu Bar to open the “Account Settings” dialog box. On the “E-mail” tab, click the 

“New…” button. In both versions, the “Add New Account” dialog box appears.

2. Start by selecting the option button that corresponds to the type of e-mail account you are trying to 

create. Depending on what you select here, the screens that follow will vary. However, they will all 

prompt you for mail server, connection, and account information- so make sure that you have that 

information ready.

3. Answer any questions posed by each screen, entering the necessary information and then clicking 

“Next >” to continue until you are finished.

4. At that point, you can click the “Close” button in the “Account Settings” dialog box to close it.Sa
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ACTIONS-

Outlook Options
SETTING OUTLOOK OPTIONS:

1. You can access the default options in Outlook 2013:2010 by clicking the “File” tab in the Ribbon and 

then clicking the “Options” button to open the “Outlook Options” dialog box.

2. In this dialog box, you can click on a category listing at the left side in order to change any settings that 

then appear at the right side. When finished, click the “OK” button to save your changes.

3. You can access the default settings of Outlook 2007 by selecting “Tools| Options…” from the Menu Bar.

4. There are seven tabs that you can use to change the settings of Outlook 2007. Make any changes that 

you want to one the appropriate tabs, and click “OK” to save your changes.

USING OUTLOOK HELP:

1. You can access the help in Outlook by clicking the “Microsoft Outlook Help” button. This will open the 

“Outlook Help” window.

2. Notice that this window can be closed by simply clicking the “x” in the upper right corner of the window 

when you are finished using the help files.

3. If you wish to search through the help files for a topic, you can easily type the words for which you wish 

to look into the long white text box in the toolbar at the top of this window.

4. You can then decide where you wish to search for the information by clicking the drop-down button next 

to the “Outlook Help” title in Outlook 2013 or the “Search” button in Outlook 2010:2007, and then 

selecting a choice from the drop-down menu.

5. Once you have selected where to search, just click the “Search” button to let Outlook search for the 

words or phrases that you entered.

6. Any matching help topics are then displayed in the “Outlook Help” window as a listing of hyperlinks. You 

can click on the name of a help topic to view its content in the “Outlook Help” window.

7. To go back to the main listing of help topics, just click the “Back” button in the toolbar at the top of the 

window to return to the list. You can then continue reading other topics, perform another search, or 

simply close the window if you are finished.

8. Should you want to print any topic that is displayed in the “Outlook Help” window, you can do so by just 

clicking the “Print” button in the toolbar at the top of the “Outlook Help” window.
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EXERCISES-

Outlook Options
Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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15.1- Creating a Delegate

15.2- Acting as a Delegate

15.3- Deleting Delegates

CHAPTER 15-

Delegates
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15.1- Creating a Delegate:

If you have a person that you would like to assign as a delegate, you can give that person

permissions to send and receive e-mail and schedule items and tasks on your behalf. When you make a

person a delegate to your account, that person can then access your Outlook account and perform the

actions that you have allowed them to perform. To use the delegate features, you must be using an

Exchange Server Account within Outlook, and both you and your delegate must be using the same version

of Outlook. To create a delegate in Outlook 2013:2010, click the “File” tab in the Ribbon, and then click the

“Account Settings” drop-down button. From the drop-down menu that appears, select the “Delegate Access”

command. Then click the “Add” button to launch the “Select Names” dialog box, where you can select the

name of the individual to whom you want to grant delegate access. Then click the “Add” button at the

bottom of the dialog box to add them to the list. When you are finished, click the “OK” button.

If using Outlook 2007, you will need to select “Tools| Options…” from the Menu Bar and then select

the “Delegates” tab. Here you will add the delegate and set up the necessary permissions for that person.

Click the “Add…” button to launch the “Select Names” dialog box, where you can then add the name of the

individual to whom you want to grant delegate access. When you are finished, click the “OK” button.

In either version, you then set their permission levels in the “Delegate Permissions” dialog box. For

each folder in your Outlook account, you use the drop-down to the right of each folder’s icon to set what

level of access you want them to have. You can also check any checkboxes to grant additional permission

to read private items, receive copies of meeting-related items, or send the delegate an e-mail listing their

permissions in your account. Click “OK” when you are done.

You will then return to the “Delegates” tab. At the bottom of this tab, you can select the option button

that corresponds to how you would like Outlook to handle meeting requests with delegates. Then click the

“OK” button to set your delegates.

Delegates

15.2- Acting as a Delegate:

If you are the delegate to someone’s Outlook account, you can easily switch to that account from

your own Outlook account. You can do this in Outlook 2013:2010 by clicking the “File” tab in the Ribbon and

then clicking the “Open & Export” or “Open” command at the left side of the backstage view. Then click the

“Other User’s Folder” button to the right. You can do this in Outlook 2007 by selecting “File| Open| Other

User’s Folder…” from the Menu Bar.

In either version, the “Open Other User’s Folder” dialog box will appear. Here you can click the

“Name…” button to select the name of the user whose account you wish to access. Then click the “OK”

button. You can also use the “Folder type:” drop-down to select which folder you wish to access. Click “OK”

when you are ready. This will open up the other user’s account in Outlook.

15.3- Deleting Delegates:

When you no longer wish for a delegate to be able to access your Outlook account, you can simply

delete the delegate. If using Outlook 2013:2010, click the “File” tab in the Ribbon and then click the

“Account Settings” button. From the drop-down menu that appears, select the “Delegate Access” command.

If using Outlook 2007, select “Tools| Options…” from the Menu Bar, and then click the “Delegates” tab.

From there click the name of the delegate that you want to delete. Press the “Remove” button to delete the

selected delegate. Then click the “OK” button. You should then restart Outlook.Sa
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ACTIONS-

Delegates
CREATING A DELEGATE:

1. To create a delegate in Outlook 2013:2010, click the “File” tab in the Ribbon, and then click the “Account 

Settings” drop-down button. From the drop-down menu that appears, select the “Delegate Access” 

command. Then click the “Add” button to launch the “Select Names” dialog box, where you can select 

the name of the individual to whom you want to grant delegate access. Then click the “Add” button at 

the bottom of the dialog box to add them to the list. When you are finished, click the “OK” button.

2. If using Outlook 2007, you will need to select “Tools| Options…” from the Menu Bar and then select the 

“Delegates” tab. Here you will add the delegate and set up the necessary permissions for that person. 

Click the “Add…” button to launch the “Select Names” dialog box, where you can then add the name of 

the individual to whom you want to grant delegate access. When you are finished, click the “OK” button.

3. In either version, you then set their permission levels in the “Delegate Permissions” dialog box. For each 

folder in your Outlook account, you use the drop-down to the right of each folder’s icon to set what level 

of access you want them to have. You can also check any checkboxes to grant additional permission to 

read private items, receive copies of meeting-related items, or send the delegate an e-mail listing their 

permissions in your account. Click “OK” when you are done.

4. You will then return to the “Delegates” tab. At the bottom of this tab, you can select the option button 

that corresponds to how you would like Outlook to handle meeting requests with delegates.

5. Then click the “OK” button to set your delegates.

ACTING AS A DELEGATE:

1. If you are the delegate to someone’s Outlook account, you can easily switch to that account from your 

own Outlook account. You can do this in Outlook 2013:2010 by clicking the “File” tab in the Ribbon and 

then clicking the “Open & Export” or “Open” command at the left side of the backstage view. Then click 

the “Other User’s Folder” button to the right. You can do this in Outlook 2007 by selecting “File| Open| 

Other User’s Folder…” from the Menu Bar.

2. In either version, the “Open Other User’s Folder” dialog box will appear.

3. Here you can click the “Name…” button to select the name of the user whose account you wish to 

access.

4. Then click the “OK” button.

5. You can also use the “Folder type:” drop-down to select which folder you wish to access.

6. Click “OK” when you are ready. This will open up the other user’s account in Outlook.

DELETING A DELEGATE:

1. When you no longer wish for a delegate to be able to access your Outlook account, you can simply 

delete the delegate. If using Outlook 2013:2010, click the “File” tab in the Ribbon and then click the 

“Account Settings” button. From the drop-down menu that appears, select the “Delegate Access” 

command. If using Outlook 2007, select “Tools| Options…” from the Menu Bar, and then click the 

“Delegates” tab.

2. From there click the name of the delegate that you want to delete.

3. Press the “Remove” button to delete the selected delegate.

4. Then click the “OK” button. You should then restart Outlook.Sa
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EXERCISES-

Delegates
Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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Outlook Keyboard Shortcuts

Command Key

Next Item (with item open) Ctrl + ,

Previous Item (with item open) Ctrl + .

Go to a Different Folder Ctrl + Y

Create an Appointment Ctrl + Shift + A

Create a Contact Ctrl + Shift + C

Create a Contact Group Ctrl + Shift + L

Create a Folder Ctrl + Shift + E

Create a Journal Entry Ctrl + Shift + J

Create a Meeting Request Ctrl + Shift + Q

Create an E-mail Message Ctrl + Shift + M

Create a Note Ctrl + Shift + N

Create an Office Document Ctrl + Shift + H

Create a Discussion Posting Ctrl + Shift + S

Create a Task Ctrl + Shift + K

Create a Task Request Ctrl + Shift + U

Save Item Ctrl + S

Save and Close or Send Alt + S

Save As F12

Undo Ctrl + Z

Delete Ctrl + D

Print Ctrl + P

Copy Item Ctrl + Shift + Y

Move Item Ctrl + Shift + V

Check Spelling F7

Flag for Follow-Up Ctrl + Shift + G

Forward Ctrl + F

Find F3

View Inbox Ctrl + Shift + I

View Outbox Ctrl + Shift + O

Command Key

Reply Ctrl + R

Reply All Ctrl + Shift + R

Check for New Mail Ctrl + M

Accept Alt + C

Decline Alt + D

Dial Contact (in Contact Window) Ctrl + Shift + D

Bold Text Ctrl + B

Bullet Text Ctrl + Shift + L

Italicize Text Ctrl + I

Left Align Text Ctrl + L

Center Align Text Ctrl + E

Underline Text Ctrl + U

Increase Font Size Ctrl + ]

Decrease Font Size Ctrl + [

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Clear Text Formatting Ctrl + Shift + Z

Switch to Mail Ctrl + 1

Switch to Calendar Ctrl + 2

Switch to Contacts Ctrl + 3

Switch to Tasks Ctrl + 4

Switch to Notes Ctrl + 5

Switch to Folder List Ctrl + 6

Switch to Shortcuts Ctrl + 7
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